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Note On The Admin Process for Service Requests:

The Citizen Portal is where the request will be made from a citizen or a staff member.

If a request comes in from a citizen the options available within the portal will direct said request
to the correct department.

However, staff may need to reassign after further review of the request in VueWorks itself.

If you have images, please upload them to start the request process.

Click next when ready to proceed.
Staff or the Citizen will need to add a location

This can be done by either using the Click/Tap or on Map or by adding the address.

If you use the Click/Tap on Map option a Map will appear.



Staff or the Citizen will need to to find the location by clicking their mouse, and dragging around
the mouse until you find the location. You will notice the location marker (looks like an upside
down teardrop) has an ‘X’ that needs to be put on the location.

Click done when the ‘X’ is on the correct spot.

You will then first select the Issues Category and then select from the Issues List.

Click Next when you are ready to move on to the next step.



Staff or the Citizen will need to enter the requesters personal information.

When finished click next.

This will end an email to the Citizen letting them know the request has been made on their
behalf. It is up to the staff member responding on how or if the citizen will

This will also send an email to the Staff who should be taking care of the request.
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Note On The Admin Process for Service Requests:

The Citizen Portal is where the request will be made from a citizen or a staff member if assisting
the citizen.

Process a Service Requests Through the Portal:

If a request comes in from a citizen the options available within the portal tries to direct said
request to the correct department. However, staff may need to reassign after further review of
the request.

The ‘Role’ that the service requests get assigned to will trigger email notifications to the staff
members that would handle the request.

To view the request open Okta then select VueWorks

In the menu on the left of your screen, open ‘Service Requests’ then select ‘Find / Manage /
Report’ and search for the Service Request



A box will pop up and you can search for your service request using the Filter tab or
you can use the Table View tab. To open the Service Request, click the box with the
pencil to the left that is associated with the email you received.

The Manage Service Requests box will open.

THE AUTO SEND BOX WILL BE AUTOMATICALLY CHECKED. IF YOU DO NOT WANT TO
USE VUEWORKS TO SEND THE RESPONSE, UNCHECK THIS.

When the Service request opens click on the keyboard with a down green arrow to
update the assigned to.



A Service Request Assignment box will pop up.

Select who to assign the service request to by typing in the ‘Select Who to Assign’

You can also narrow down the list of names by first selecting the role, then the name.

Fill out the important information to help the assignee understand the citizens request.

The Response box is where all responses after research are entered. If the Auto Send box is
selected your response in this box will be emailed to the citizen.



To add a comment that will not be seen BUT IS STILL PART OF PUBLIC RECORD the staff
member will complete the research and add any notes to the Comments tab.
Click Add Comment, write what you found during research, and click Save.

There will be a timestamp added to the comment.

If it is an Engineering Department request or issue to resolve, the assignee will respond

in one of two ways:

1) through VUEWorks (using above mentioned Response Box and Auto Send
checkbox) or

2) outside of VUEWorks using a County GMAIL account. Please make sure to note this
in the Service Request by Copying the email response into the Response Box

To add an asset to the Service Request, click the Asset Tab



Add the asset using one of the following green button options. From Map may be the
easiest.

When you select from the Map, the screen will change to a map view. From here you can add
an asset.

If a Work Order is needed, click the Work Order tab, then add Work Order.
Note: If you add a work order from the Service Request, when the Work is completed, and the
Work Order closed, it will automatically close the Service Request too.

If staff does not need to create a work order, staff will need to close the Service Request.

When the Service Request is completed, staff will need to close the service request.
DO NOT MISS THIS STEP as this will help with reporting.
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Note On The Admin Process for Service Requests:

Open Okta and select VueWorks.

When VueWorks opens, click Engineering in the menu on the left

Click Projects

Click ‘Add Project’



A new pop up to add the project will appear. Enter the project information that was received
from the Leadership.

Enter Project Name

Enter Group Associated with

Project Form

Click Create

The new project will now appear in the Associate Projects on the work order screen
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AS-BUILT PROCESS DEFINITIONS
Discovered Asset - asset which is not in GIS and was not added with the project.
End Date - the date the asset is taken out of service, typically will use the current date unless
better information is available.
Event - an asset in GIS, can be a physical asset (i.e. culvert) or a non-physical asset (i.e. snow
route, road ownership). This term is used in Event Editor and Field Maps.
Measure - the location, in miles, measured from the beginning of the route. Point assets (i.e.
cattle guard) are defined with a single measure while a linear asset (i.e. guardrail) has both a
begin and end measure.
Modified Asset - update attribute(s) of an existing asset without replacing the existing asset.
Typically done if making a correction or historic condition assessment data needs to be
maintained (only applicable for cattle guards, culverts, guardrails, and sign mounts). Modifying
an asset will maintain historic condition assessment data but not retain the old attribute values.
To keep a record of the old attribute values enter a note in the remarks attribute detailing what
attribute(s) changed, the old value(s), and the date of the change.
Move Asset - change the location (route, measure) of an existing asset. There are two cases
which must be considered:

1. Correct an incorrect location or move the asset to a new location while
maintaining the historic condition assessment data (cattle guards, culverts,
guardrails, and sign mounts) this must be done using Event Editor.

2. Relocate or correct an existing asset location and there is no historic condition
assessment data that needs to be maintained: Event Editor may be used to
change the location as above or Field Maps may be used to retire/replace the
asset.

New Asset - an asset which was constructed/installed as part of the project which did not exist
before the project.
Replace Asset - an existing asset is removed and replaced with a new asset. This involves
retiring the old asset and creating a new asset. The old asset is added to the Retired Asset
activity work order and the new asset is added to the New Asset activity work order.
Retire Asset - an existing asset is removed. The asset is attached to the Retired Asset activity
work order and an end date for the asset is entered in the GIS.
Route - the road number (mainline, county maintained subdivision, or PID roads) along which
the asset exists.
Start Date - the date the asset is put into service - please note that if a future date is entered,
the asset will not be available to attach to work orders until that date.
Work Order - a request to collect or update asset data. The work order will have one or more
assets associated with it. The work order’s activity may be Discovered Asset, Modified Asset,
New Asset, or Retired Asset.



Capital Assets Specific Process

Project Manager (PMs) :

Open Okta, then select IAMGIS Portal:

Select Event Editor without GASB

(You may need to scroll down)

Then click the blue Larimer County IAM GIS Portal button



New Point Asset Project Process

Once you are in the location you are editing, Open the Edit tab.

Click the Point Events icon t o open the Add Point Events widget in the side bar.

Note the Route Network is selected in the

Network dropdown by default

Change the Event Layer if needed.

Your selected Route ID does not need to match the example.



Click the Select a Location on the Map button and click on the map to select a location to place the new

event. 

You will need to adjust the Start date DO NOT ENTER THE END DATE on a new asset. Click the

down arrow to open the date selector.

Click the Prevent Measures not on route (only if it is not currently selected).
Checking the box means an error will be returned if

a measure value outside of the route measure range

is entered.

Click Next

A list of all event attributes will populate.

(The value is currently null that will change)



You will need to populate the new event record attributes. Use all CAPS when filling these

attributes in.

Choose domain values from a dropdown, select dates from a date-picker, and/or type in values. 

Do not enter the end date. (Only enter an end when retiring an asset. When retiring an asset the PM
will create a work order first, then do the step in Event Editor when the WO gets re-assign after field
work is done)

Alternatively, use the Copy Attributes (eye dropper) tool to select the same attribute values from an
existing point event feature (Bridge in this example) from the map, and further edit the values as
applicable.  The event layer will need to be turned on in the map to do this (Map tab > Layers list). 
 ** Frequency of inspections for bridges is entered in the number of months.

Your populated attributes do not need to match the example.

Click Save

To Verify that new attribute data was successfully added. To do this, choose the event that was edited
from the Layer dropdown. Then, use the Rectangle selection tool to select in the location of the newly
added event data from the map (the map should still be zoomed to this extent). This will cause the edited
record to load in an attribute grid at the bottom of the page. The Identify tool can also be used to review
the new event data that was added (the layer needs to be turned on in the map).

You are now done in Event Editor and ready to begin the work order for the construction
manager.



New Linear Asset Project Process

Once you are in the location you are editing, Open the Edit tab.

Click the Line Events icon in the Edit ribbon to open the Add Linear Events widget in the side bar.

Click the Select a Route on the Map button next to

Route ID in the From section of the Add Linear Events widget.

Use the mouse pointer to click on the map to select a route.

Your selected Route ID does not need to match the screenshot.

Click the down arrow in the From Measure
box and select Use the Route Start.

Alternatively, click a location on the route or
type in a measure value.

Click the Select a Location on the Map next
to Measure in the To section, and then use
the mouse point to select a location on the route.



Click the down arrow next to the Start Date
field to open the date selector.
Select a date from the calendar widget or
check the box next to Use route start date.
By default, today’s date is selected.

Do not enter the end date. (Only enter an end when retiring an asset. When retiring an asset the PM
will create a work order first, then do the step in Event Editor when the WO gets re-assign after field
work is done)

Check the boxes for Retire overlaps, Merge coincident events,
and Prevent measures not on route.

Click Next

Uncheck the box in the header of the All Attributes area.

Check the box for Show layer names at the bottom of
the All Attributes area. This will add a Layer column to
the table.



Scroll through the list of layers and check the box next to an
event layer you wish to add data to for the selected Route
and Measure range.
For the selected event, specify event attribute values by
choosing domain values from a dropdown, selecting dates
from a date-picker, and/or typing in values.
Alternatively, use the eye dropper tool to select the same
attribute values from other event(s) on the map.

Click Apply

Click Save - You are now done in Event Editor and ready to begin the work order for the
construction manager.

Verify that new attribute data was successfully added. To do this, choose the event that was edited
from the Layer dropdown. Then, use the Rectangle selection tool to select in the location of the newly
added event data from the map (the map should still be zoomed to this extent). This will cause the
edited record to load in an attribute grid at the bottom of the page.

The Identify tool can also be used to review the new event data that was added (the layer needs to be
turned on in the map).



Work Order As-Built Process
Project Manager will then open VUEWorks

Open Okta and select VueWorks.

When VUEworks opens, turn on the layer in which the asset fits (or asset type that was created

above) in layers on the map.



Find the asset that was just created by the Project Manager in Event Editor.

Click on the asset and a box will open up on the top right.

You will click the option ‘Add Work Order’

**Please note that if the project is replacing an old asset you will need two (2) Work Orders.

One to retire the original asset and one for the new asset.

The Create Work Order box will appear. Fill out the dropdowns based on the work order

needed. For field collection (no money needing to be allocated) use the Group ‘As Built/Field

Collections’. The location will be listed below the location box.



Click Create ➡️

This will need to be assigned to the Construction Manager that is assigned to this project.

To assign, click the keyboard with the green arrow next to the Assigned To.

Filter by Role, then select the individual you are assigning to.

Fill out all the important information to make the Construction Managers scope of work easy

to identify.



Click Save along the bottom

to send the Work Order via email to the assigned staff member.

Construction Manager

The Construction Manager will receive an email with the work order information in it. They will

go to VUEWorks or WorkforceVue and retrieve the work order.

If using WorkforceVue please sync when you open the app.

If you retrieve it in WorkforceVue you can click the option Linked Asset and then Map. This will

open the asset in Fieldmaps.

⬅️ This is a work order in WorkforceVue



⬅️ Click Linked Assets here to go to Field Maps

Or in the office you can use Event Editor. This will be if anything needs updating from what the

PM had originally entered.

Open VUEWorks or WorkforceVue and assign back to Project Manager.

Must sync after you assign a work order.

You are done.

Project Manager

The Project manager will receive an email that they have been assigned a work order.

Open VueWorks and search the ‘Open My Work Order’ and click on the asset to verify the

attributes that were changed.

If everything looks good, close work order out. If you find a typo or error, please correct it in

Event Editor, then close the work order in VueWorks.



Work Order Creation in WorkForceVue.

Open the WorkForce App on your device.

Select the ‘ADD’ green button

The screen will pull to enter new information into the new work order. Please fill this out

according to the work required in the field.



When done, hit Continue

When you hit continue, your work order will present itself differently on your screen indicating

you are ready to accept it. Please click the checkmark on the top right. You are now able to

sync when attached to wifi, or work within this work order to complete the field work.

You will assign this Work Order to the Project Manager when the field work is done.

Remember to Sync so the work order will be sent to the proper Project Manager.



SCENARIOS:
• Unexpected modification - Construction Manager would have to create a modified

asset work order in the field using the WorkForce app (unless one already exists for the project,

in which case they would just add the asset to the existing work order), link to project, attach

asset, make changes in Event Editor or Field Maps. When field work is done, reassign the work

order to the Project Manager to verify and close.

Use the above instructions for Work Order Creation in WorkForce Vue Process.

• Unexpected replacement - An existing asset is unexpectedly removed/destroyed/etc.

during construction and needs to be replaced. The Construction Manager will work with the

Project Manager to create the new replacement asset or they will create the asset themselves

in Event Editor (or Field Maps). This will be two (2) work orders, one creating the new asset to

replace the one that was damaged, then one retiring the damaged asset once the work is

finished.

Once the Asset is created, the Construction Manager or Project Manager will create a new work

order (unless one exists, in which case they would just add the asset to existing work order), link

the work order to the project (unless using an original WO, in which case it is already linked to

the project).

The Construction Manager or Project Manager will also create a new work order for the current

asset that is to be retired. Again this work order will need to be linked to the project.

Once all field work is done, the old asset will need to have an end date put in using Event Editor

and the work order will need to be closed out by the Project Manager so please remember to

assign it to the Project Manager.

• Discovered asset - The Construction Manager will create a work order using the the

WorkForce app (unless one exists, in which case they would just add the asset to existing work

order), links work order to project, creates asset in Event Editor or Field Maps, attach the

discovered asset to the work order. Once field work is completed, reassign the work order to

the Project Manager to review and close.

• Expected work didn't end up happening - The Construction Manager will put a

comment on the work order and reassign it to the Project Manager to review and close. The

Project Manager will have to make corrections in Event Editor if the new/updated asset was

documented in the system before creating and attaching it to the work order.



• Moves: If an existing asset moves to a new physical location OR an asset isn't in the

right location in the system and needs to be corrected - location adjustment REQUIRES the use

of Event Editor (field maps does not work …yet). The Construction Manager will work with the

Project Manager on who should update Event Editor to make sure that the asset presents itself

in the correct location moving forward.
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Stormwater
When a request comes in, the role ‘Stormwater’ will receive an email alert from the
Customer Request Portal Service Request regarding a stormwater issue.

The staff member who decides to complete the task will re-assign it to themselves to
remove it from the role. This will alleviate duplicate work.

To do this, open Okta then select VueWorks

In the menu on the left of your screen, open ‘Service Requests’ then select ‘Find /
Manage / Report’ and search for the Service Request



Select the Service Request ID you are wanting to work on. When the Service request
opens click on the keyboard with a down green arrow to update the assigned to.

When you click that keyboard with a down green arrow a Service Request Assignment
box will pop up.

Select who to assign the service request to by typing in the ‘Select Who to Assign’

You can also narrow down the list of names by first selecting the role, then the name.



The staff member will complete the research and add any notes to the Comments tab.
Click Add Comment, write what you found during research, and click Save

If there are any assets associated with the Service Request, click on the Assets tab.
Make sure the applicable layers under Stormwater-MS4 and Structures are turned on.



Click ‘Add Assets’ from Map and select the applicable assets. They will show up as a
list under the Assets tab once they have been added.

If it is an Engineering Department request or issue to resolve, the assignee will respond
in one of two ways:

1) through VUEWorks or

2) outside of VUEWorks using a County GMAIL account.

If responding through VUEWorks, you must check the Auto Send box next to the caller
information to send an email response. Please note that this will be automatically checked when
it comes in.



If responding using County GMAIL uncheck the ‘Auto Send’ box. The responder must still
make a note in the service request Response box.

If the request is a RAB issue, the Engineering Department staff member will change the
department in the Service Request to RAB. The VUEWorks system will then send the
request to the RAB Department where it will be assigned to the appropriate Group.

If the request is not an Engineering issue, the Engineering staff member will transfer the
request to the appropriate Department using either VUEWorks if the Department has a
VUEWorks account or by County GMAIL if the County Department does not have a
VUEWorks account. (Currently ONLY Road & Bridge (RAB) uses VUEWorks.)

If the request is transferred to a department that does not have a VUEWorks account,
the Engineering staff member will need to send the request using their County GMAIL
account. It is important to add notes in the response box stating who and when the
request was transferred to. Make sure the Auto Send checkbox is unchecked during this
step!

** An optional step is to attach the sent email for the record.
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Work Order As-Built Process
Project Manager will then open VUEWorks

Open Okta and select VueWorks.

When VUEworks opens, turn on the layer in which the asset fits (or asset type that was created

above) in layers on the map.



Find the asset that was just created by the Project Manager in Event Editor.

Click on the asset and a box will open up on the top right.

You will click the option ‘Add Work Order’

**Please note that if the project is replacing an old asset you will need two (2) Work Orders.

One to retire the original asset and one for the new asset.

The Create Work Order box will appear. Fill out the dropdowns based on the work order

needed. For field collection (no money needing to be allocated) use the Group ‘As Built/Field

Collections’. The location will be listed below the location box.

Click Create ➡️

This will need to be assigned to the Construction Manager that is assigned to this project.



To assign, click the keyboard with the green arrow next to the Assigned To.

Filter by Role, then select the individual you are assigning to.

Fill out all the important information to make the Construction Managers scope of work easy

to identify.

Click Save along the bottom

to send the Work Order via email to the assigned staff member.
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Open Okta and select VueWorks.

To create a work order please select Work Orders on the left side of the page.

Select Add New Work Order – Fill out the drop-down fields to match the work required then click

‘Create’



Select the map icon next to the Location field. This will open your map.

Make sure the layer that you are wanting to view has been selected and the asset has been created.

You will have to zoom in far to be able to select an asset. Click on the asset you want. This will populate

on the Work Order. Click Done

You will notice that the location field is now populated.

Click Create



Fill out the Description, Priority and Term Dates. The due date can be left blank. The Description must

start with Project number if applicable.

Once that is complete, you can move on to finish the Work Order details. If this is a part of a project, you

will associate it with that project.

Fill out highlighted areas. (addendum only if it is a change order, see addendum instructions)

Quick Tip is to click the arrow pointing up to make the bottom screen larger.



Under the Documents tab, you will upload the Scope of Work from the Contractor.

Click browse to find and select file to upload. File type must be a PDF.

This will pop up if the document is attached..



Then go to the workflow tab to submit the Work Order to begin the approval process.

This step will trigger the flow to the Director or Assistant Director for approval. They will receive an

email then login to sign the Approval Signature on the details tab, then hit complete on the Workflow

tab.

The Work Order will then go to the Admin Team for creation of the Purchase Order.



Purchase Order is created in FRAN. This may take 1-2 business days to complete.

Once that step has been completed by Admin in FRAN, A will go into the Work Order in VueWorks and

add the Child PO Number into the Work Order.

The Work Order will then be routed back to the Project Manager to print and send to the contractor for

their records.

When the work is complete, the Project Manager will update the status. This is important as it will send

an email to everyone on the notification list. Admin will be added to this list, so admin will know to close

the PO.

**As a reminder contractors/vendors do not need to sign the Work Order as the Scope of Work

submitted to the Project Manager is sufficient.

**The PO will be attached to Documents

Print the PO to PDF to send to the vendor. Select the attachments you would like to send as well.



PO

Scope of work

Work Order

The PDF will pop up and you can download then send it to the vendor.

If you select the documents to attach, you will notice it auto merges the documents.



You see how it says 1 of 5 pages? That means that attachments are all there.

This will be sent out to the vendor via the PM in an email.

Addendum Guide
Open your original work order.
Go to the work orders tab and click Add New

You will follow the work order creation steps from above.

The only difference is you will fill out the addendum portion.
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